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AC2 within the GRS Simulation Chain
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What is AC2?

AC2= ATHLET + ATHLET-CD + COCOSYS
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From: 11), Wikipedia
9 8
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AC2: Overview and Components

AC?: System code package of GRS

= simulation of normal operation, design-
basis accidents

= design extension conditions up to severe
accidents including fission product release

= nuclear power plants, research reactors,
advanced reactor designs and FE storage
pools

AC? features:

= integral simulation of design basis
and design extension conditions

AC? User Meeting 2023
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Motivation for the Development of AC? (1)

Water Tank

New reactor concepts (Gen lll,IlI+, SMRs, MMRs,...) impose special challenges:

_ Condenser
Passive safety systems

Innovative components (e.g. compact heat exchanger, heat pipes)
New working fluids (e.g. Molten Salt, He, sodium, potassium, .....)  Steam
New containment concepts Generator
Large water pools

Potassium Heat Pipes
(steel)

.

Primary Heat Decay _
Exchanger Heat Monolith Core
Exchanger

REACTOR POOL

AI203 - Reflector

From: 2) J. Chénais, 2018

Liquid Capillary flow

Liquid

From: 4) W. Sterbentz 2017
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Adapted from: 6) M. Niemi 2017
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Motivation for the Development of AC? (2)

Advanced reactor concepts require partially coupled (multi-physics) simulations of phenomena in the
core, cooling circuit, containment and fuel pool

AC? approaches this challenge by:
Further development of the specific models for passive safety systems and innovative components

Coupling ATHLET/ATHLET-CD und COCOSYS for the simulation of flow phenomena in cooling circuit and
containment

Coupling thermo-hydraulics and neutron kinetics with ATHLET and FENNECS
Simplifying input creation for integral analysis

Improved compatibility of the phenomenological models

Extension to new working media and homogenization of material values
Integral validation of the overall system

Uniform programming standards and QA requirements

AC2 User Meeting 2023 27.- 29 Nov. 2023 6
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AC?2 2023: Content of the Distribution

In addition to the AC2 (ATHLET, ATHLET-CD, COCOSYS) code, AC? 2023 package will also contain:

= ATLASNneo/ATLAS for the visualisation of the simulation results and interactive control of plant simulators

= ADM (ATHLET Input Modeller) for graphical generation of thermo-hydraulic- und BOP models for ATHLET/CD
= FENNECS: 3D-Neutronic-Diffusion Code for compact cores

= PEMTY: Grid generator for FENNECS

= Coupling Interfaces to CFD/CSM-Codes

= Plug-Ins templates for User-models ATHLET
lug-In
« Tools filr ATHLET und terface
ATHLET/
COCOSYs ATHLET- COCOSYS
= Documentation —

3D

= Sample inputs nterface

Interface

CFD/CSM

FENNECS Interface/
PreCICE ATLAS/

ATLASheo
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ATHLET 3.4 ‘ ACZ

RS

Numerous new and improved models ‘ 'ATH LET

Heat transfer and pressure loss correlations for compact heat
exchangers in SMRs

Improved consideration of form losses
Widely updated fuel rod model for DBA analyses

New two-phase working fluids and NC gas components
Divers model updates, e.g. T-junction model, oxidation model

From: 5) VDI 2013

Primary
f @ side flow
\ 4 1: bend 2: U bend Pipe outlet
Fuel swelling
and relocation |
Pipe Inlet

3: S bend 4: 3d double bend
From: 6), Niemi 2017
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ATHLET-CD 3.4 T

Melt relocation through the core bypass channel
VVER-440 specific model capabilities

Axial configurable core composition
Harmonization between ATHLET-CD and ATHLET

Heat transfer correlations

ATHLET water properties used in AIDA

Further harmonization under progress

obere KSS

| untere Kss|

|
: N~
(f (=
o

From: 8), Drath 2004

VVER-440 lower core part

A NC?
QY ATHLET-CD
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WATER COOLING BOILING AIR COOLING

COCOSYS 3.2 -

= Improved pool simulation (heat transfer, boiling, level)
= Improved building condenser model (stability two-phase g b e 5
flow, non-condensable gases, pressure loss) & [ oo 5
3 g
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FENNECS — Deterministic Neutron Kinetics Code for Irregular Geometries ‘ FENNECS

Finite ElemeNt NEutroniCS ‘ '

Time-dependent 3-d few-group finite element-based diffusion and SP; transport (steady state) code
Geometrical flexibility to model complex and irregular geometries of SMRs and MMRs
Also applicable to Generation IV reactor concepts and LWRs

Features: Potassium Heat Pipes
Coupled with the GRS thermal-hydraulic system code ATHLET e
Coupling with CTF in progress
Core radial thermal expansion model for SFR simulations

AI203 - Reflector

_ Primary Heat Decay
Control rods: Exchanger  Heat Monolith Core

— Axial movements, different axial material zones, Exchange
— in-plane rotation of control drums.

Critical boron search.

lodine/Xenon and Promethium/Samarium dynamics

Visualization: geometry, material, power density, neutron flux distribution, thermal-hydraulic parameters

From: 4), Sterbentz 2017
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0

ing Irregular Geometries for FENNECS ‘ FENNECS

PEMTY - Software for Mesh
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Numerical Toolkit (NuT) v2.0.2 dim: 198,673 £[s]: 0 — 500 — 800

m Solver W Jacobian /|feval mAll

2210:26

= Numerical Toolkit (NuT) QAN o> I N —
- Based on PETSc Library (open source)
- Coupled via MPI-Interface mumps 1x B
 Multithreading

= Significant performance gain for ATHLET MuMps 4x B

0:00h 8:00h 16:00h 24:00h 32:00h 40:00h 48:00h

* extrapolated
t = 0.1s after 45h

= New feature:
° Support Of COCOSYS THY- - NuT-Worker(s) libnut_core
mo d u | e RAMAIN ATHL  Wrapper COM abstract mapping
entities of type
= Current development work: | - controllr

« Support coupled calculations of
ATHLET/CD and COCOSYS with
common equation system A\ _group_comm = MP1_comm_world

\i

mpiexec -n 1 ./athlet : -n 4 ./nut

AC2 User Meeting 2023 27.- 29 Nov. 2023 13
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ATLASNheo AT LAS

= Dynamic simulation control
P t . @ ATLASneo(3.7) - unnamed* - O *
= Postprozessing . —
N e &Q @ @ ¥ s =
[ | Runs under WlndOWS and Llnux t;F Hdf5Dock - pipe-left_2phases.14.h5 .8 X  SimulationDock - unnamed & X PlotDock - unnamed 5 X
el 0 . 940 Config Simulation » Toobar
| Dataformat: HDF5 | > Toolbar _ Binary: ‘choosesimulatordll... |E| 0.02
< Name Type " Input: ‘choose input file ... | El 0.018
= pdf2H DF CO nve rter v plotdata Groug Controller | ‘ﬁle with spedalized python controller [0pti0...| El 0.018 — 2;
» GCSM Groug ‘ . : | = 0.014 o
_ Restart: [u] restart file [optional
i i I I v B TFO Groug 0.012
= 2D-visualization in development i T D ‘
v [ GASINJECT!  GrOUE smuston : [smtd | 0008 _
» = Groug 0-008 \
Additional Arguments: ‘-d hdf5_writer | 0.004
> MULTICOMP Groug \
_ Run Info: 0.002
v GASINJECT2 Groug .
> B- Group 0o 2 4 & 8 1 12 14 16 18 20 22 24 %
> MULTICOMP Groug
> [ GASINJECT3 Groug PlotDock - unnamed F X
> OUTLET Groug > Toobar
v PIPE1 Groug
v = Group soo
> [£] NODE1 Table
> [£E] NODE2 Table
> [£] NODE3 Table 00
> [El NODE4 Table
> [E] NODES Table ¢
> [£E] NODE6 Table
> MULTICOMP Groug 500
component Groug ,,
- d..
< — g o 2 4 & 8 10 12 14 1 1 20 22 24 X
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AC2 Design Modeller (ADM)

Interactive application for graphical modeling and input

generation for ATHLET
ATHLET GCSM Modeller (AGM)

— Used for system simulation in several plant
simulators

ATHLET Thermohydraulic Modeller (ATM)

— Supports many models (TFO, HCO, ROD,...)

-
€A controller_test_gcsm_setpoint_switch.prt

"’l.l"!I!F’- o — t—

View Scale Mode: Editing

| 4 & ~|6csm vIEI|¢|

AGM

ATHLET input data I&C systems (GCSM)

(TFO, HCO, network,...

ATHLET Input Modeller for Thermohydraulics and IC&C 02.02.2021 13:49:08

File Edit View Scale Insert Find Service Simulation Tools Window Help GCSM ATHLET

DR -Bld|Xxmax o BEA Y vRIG LR 20

%3040 ¥:-120.0 Scalel25.6 % Objects 53 Selected 0 Grid |Snap |
. =
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Coupling Capabilities of AC? ATHLET pipe _CSM mode
in structure
Neutronic-Codes 1 ) (>
HeatfluxQ, | ——
FENNECS, QUABOX/CUBBOX, DYN3D (HZDR), PARCS D0 prr——
BIPR, KIKO3D (KFKI, HU ), TORT-TD, KMACS a, N
Subchannel-Codes L Te
COBRA-TF (NC State Univ., USA) Q, o
CFD-Codes U
ANSYS CFX, OpenFOAM Q T
TSZ
Structure Mechanics Codes ) —
J>
ASTOR, WinLeck, CalculiX 1 —

libprecice Adapter
\

Plugin-Interface to couple user-defined models/functions with -
ATHLET/ATHLET-CD peaprer ppreciee

o —
New: Interface to coupling library preCICE s

ZpreCICE D] o

AC2 User Meeting 2023 27.- 29 Nov. 2023 16
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AC? - GUI

= AC2 GUI to start ATHLET/CD, COCOSYS and FENNECS stand-alone and coupled calculations

@ Ac-GuI 20230 - O X
Utilities Documentation Help

General

Working Directory |C:,|fwewworkﬂ1ej hd || Browse || Explorer |

Current AC2 Directory |C:,|"GRS-programszC2-2023.D-heta.4 | Browse Customize

ATHLET [ ATHLET-CD
COCOSYS

/| FENNECS

Input Data feninecs.sample.in | | Browse

Numerical Toolkit

Start |

Log pipe-eft_2phases. 13 pipe-eft_2phases. 14

Controls

Pause Create Main Edit Create Restart Wait Abort and dose tab

Exec cmd:
"C:/GRE-programs/AC2-2023.0-beta.4/bin/athlet main.exe" "C:/wey/work/hej/pipe-left Zphases.in" "pipe-left Zphases.14"

ATHLET: S5Start
SIEDTA: Formatting Input
: Formatting of Input: Passed

ATHO : Start of Processing Input Data
: Scan of Plugin Folder for Enabled Plugins: Passed
Basic Input Deck Syntax Checks: Passed
Input Scan for Allocations Started
Input Scan for Allocations Finished
Start Allocations of Basic Arrays
Basic Arrays Allocated
Simulation Preconditions: Passed
TOPOLOGY Data Reading: Passed

AC2 User Meeting 2023 27-29Nov. 2023 17
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AC? 2023: Development and Validation

All AC? Codes are developed and validated under strong quality assurance.

The goal is a program that is validated in accordance with regulatory requirements (SiAnf, SSG-2) and can be used in

nuclear regulatory procedures. The continuous validation of the AC2 programs for 46 years establishes their value for
research, development and application

In addition to GRS, AC? programs are validated and partly developed by long-standing partners of GRS. These are
particularly German research institutions.

AC’-Development Process

e RUB raJr

ey y p— Support C
BOCHUM HELMHDLT!E .-'_E_N Il'_l_L'-":-'l_ Feedback
DRESDEMN ROSSENDDRAF Bugreport

RWTHAACHEN ‘(IT
UNIVERSITY N

Kaslyruber institat fur [LaaiTEls (1]

TECHNISCHE g (]
UNIVERSITAT ?jUthICHm

DRESDEN

Freigabe
Doku

Hochschule

Universitat TECHNI HE
Stuttgart HOCHSCHULE 1
DEGGENDORE _J
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CPU Affinity

Intel CPUs processors (12th Gen and later) feature Performance-cores (p-core) and Efficient-cores (e-core)
p-core provide 2 logical high-performance processors
e-core provide 1 logical processor efficient, but not a fast

Problem: Windows 10 confines every background process to the slower e-cores

‘ As soon as the AC2-GUI is in the background your simulation slows down (about 50%)
Our Solution: Environment variable AC2 CPU AFFINITY
Specify CPUs to be used for AC2-Simulation: Set AC2_CPU_AFFINITY to
individual CPUs, e.g. AC2_CPU_AFFINITY = ‘0,2,3
CPU ranges, e.g. AC2 CPU_AFFINITY = 0-3,10-12

Detailed Instruction in the AC%-User Manual (determine CPU type, setting environmental variable)

AC2 User Meeting 2023 27.- 29 Nov. 2023 19
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Summary and Outlook

New Release AC2-2023
New neutronic physics code FENNECS and Analysis tool ATLASneo
Lots of new features in ATHLET, ATHLET-CD, COCOSYS, NuT available

Lots of interesting talks in the next three days
Presentations on the new versions of ATHLET, ATHLET-CD, COCOSYS, NuT, FENNECS, ATLASnheo
Talks on special new features, e.g. new working fluids, AFP2-module,...
Information on current projects
Presentations of our Users on their applications of AC2

AC2 User Meeting 2023 27.- 29 Nov. 2023 20
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Supported by:

The development and validation of AC2 is Federal Ministry

supported by the German Federal Ministry for the A 1 for the Environment, Nature Conservation,
Environment, Nature Conservation, Nuclear Nuclear Safety and Consumer Protection
Safety and Consumer Protection.

based on a decision of
the German Bundestag
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